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Preface CATIA V5 Digitized Shape Editor is a powerful application used to read, import and process parts digitized to clouds of points. These clouds of points can then be used in CATIA FreeStyle Shaper, DMU or Machinist or exported to various other formats. Digitized Shape Editor : proposes several import formats, takes special characteristics of imported shapes into account (free edges, facets, ...), if requested, ensures a fast processing of clouds (that may contain several million of points) through filtering, activation and removal functions, makes the manipulations of the various elements constituting cloud of points (points, scans, grids, tessellation) easy, provides edition functions such as merging and aligning of clouds, or creation of planar sections, provides display and analysis functions of the cloud, keeps the architecture of objects processed, provides tessellations to be used directly with other applications or for visualization, exports the models created to several formats. The CATIA V5 Digitized Shape Editor user's guide has been designed to show you how to import and edit digitized parts using these powerful tools.



Preferred Road Maps More Information



Preferred Road Maps This User's Guide is intended for the user who need to become quickly efficient with the CATIA Version 5 Could Editor. Before reading it, you should be familiar with the basic CATIA Version 5 concepts, such as the document windows, standard toolbars and menus. To make the most out of this book, we suggest that a beginning user reads the Getting Started chapter first of all and the Workbench Description to find his way around the Digitized Shape Editor workbench. More advanced users will find an Advanced Tasks chapter that should answer their needs.



Where to Find More Information Prior to reading this book, we recommend that you read the CATIA Version 5 Infrastructure User's Guide that describes generic capabilities common to all CATIA Version 5 products. It also describes the general layout of CATIA V5, and interoperability between workbenches. Conventions



What's new This table identifies what new or improved capabilities have been documented in Version 5 Release 5 of the CATIA Digitized Shape Editor. Editing clouds: New: Selection of triangles on polygon (Removing) Enhanced: Undo on polygonal trap (Activating, Removing) Enhanced: Valid Trap button (Activating, Removing) Creating sections: New: Cross sections perpendicular to a drive contour Operations on clouds: New: Merging of tessellations Enhanced: Aligning clouds: Undo on polygonal trap Valid Trap button Display options: Enhanced: Display of free edges on polygon Filtering: New: Adaptative filtering



Getting Started The following tutorial aims at giving you a feel of what you can do with CATIA Digitized Shape Editor. It provides a step-by-step scenario showing you how to use key capabilities. The main tasks proposed in the chapter are: Starting the Digitized Shape Editor Workbench Importing a File Filtering a Cloud Selecting Points on the Cloud Tessellating the cloud Creating Sections All together this scenario should take 15 mn to complete. The final cloud element will look like this:



Starting the Digitized Shape Editor Workbench The first task will show you how to enter the Digitized Shape Editor workbench The only pre-requisites for this task is to have a current CATIA V5 session running. 1. Choose Digitized Shape Editor from the Start menu. The Digitized Shape Editor workbench is displayed and ready to use.



If you wish to use the whole screen space for the geometry, uncheck Specification in the View menu.



Importing a File This task will show you how to import a file. . The Cloud Import dialog box is displayed. 1. Select the import file icon In the Format field, select Cgo. In the Selected File area, use the button ... to browse your directories and select the GettingStarted1.cgo file from the samples directory. 2. In the Options field, check the Statistics box to visualize information about the cloud you import.



In the Preview field, click Update to display the cloud you are importing. Click Apply and OK to exit the dialog box. The element Cloud Import.1 is created in the specification tree.



Filtering a Cloud This task will show you how to reduce the number of points of a cloud. Select the cloud you have just imported. 1. Select the Filter icon . The Cloud Filtering dialog box is displayed. 2. Select the Adaptative option: it removes more points on planar areas than on bent areas. Click Apply. The new cloud of points is displayed, as well as statistics about the filtering. 3. Once you have reached a satisfying result, click OK to confirm and exit the dialog box.



Selecting Points on the Cloud This task will show you how to select an area of the cloud of points. Select the cloud you have just filtered. 1. Select the Activate box is displayed.



icon and the cloud of points. The Activate dialog



2. Choose Polygonal trap in the Trap Type and Inside Trap in the Selected Part field. 3. Place the cursor on the cloud and draw a polygonal trap around the points you want to keep. Close the polygon by a double-click. The trap and the selected part are shown in red. The trap can be modified using the green arrows that appear when you place the cursor above one vertex of the trap. The deactivated points are hidden.



4. Click Apply to check or update the result. Then click OK to confirm the result and exit the action. You can recall the dialog box to Activate all points or Swap the selection.



Tessellating the Cloud This task will show you how to tessellate the cloud. Select the lower part of the car door. 1. Select the Tessellate icon



.



2. Select the Manual execution mode. A plane is displayed that is the reference for the tessellation. If necessary, use the compass to place this plane parallel to the basis of the car mirror. Then click Apply. A first tessellation is computed. It may need improvements. For that purpose, increase the value of the Neighborhood parameter until the tessellation is satisfactory.



3. You can also uncheck Triangles and check Shading for display purposes.



4. When you are satisfied with the result, click Apply and OK to exit. An element Cloud Tessellation.x is created in the specification tree.



5. Some portions of the tessellation presents holes. They can be repaired with the Constrained tessellation option. 6. Select the cloud of points, and the Activate icon to draw a new activation trap that overlaps a portion of the tessellation.



7. Select that new portion and the Tessellation icon. In the dialog box, check the Constrained option.



8. Set the tessellation parameters as above and click OK once the result is satisfactory. Proceed in the same way for all portions to be repaired.



We have repaired the car door, displayed the three tessellations in different colors and hide the cloud of points. You can use your own model or open the GettingStarted2.CATPart.



9. Select the Merge Tessellations



icon, and the three tessellations.



10. Click OK. A new tessellation without imprecise inner boundaries (seams) is created.



Creating Sections This task will show you how to create planar sections on the cloud. Go into the No Show space, select the portion of the cloud of points you have tessellated, make it visible and return to the Show space, then activate the whole cloud of points, or open the GettingStarted3.CATPart.



1. Select the Curve in Space



icon and draw two curves on the upper part of the car door.



2. Select the Planar Sections icon



and the cloud of points.



3. A reference plane, a number of plane, a step between planes and a direction are proposed by default. , select the lower curve as the guide, the Click on the guide button upper curve as the first limiting curve, the lower curve again as the second limiting curve. It may be difficult to pick the curves. Zooming in makes the picking of the curves easier. 4. Select a view parallel to the screen, the Lock Privileged Plane Orientation Parallel to Screen option of the compass. 5. Increase the number of planes and their step according to your needs either directly in the dialog box or using the arrows. The visualization on the screen is updated accordingly.



6. Select Grouped into one element in the Scans field. 7. Click Apply to check the result and click OK if it is satisfactory. The element Planar Sections.x is created in the specification tree.



Basic Tasks Managing Digitized Shape Editor Documents Importing Files Exporting a Cloud Editing Clouds Creating Sections Creating Curves Operations on Cloud of Points Analysis Tessellation



Managing Digitized Shape Editor Documents This chapter deals with the management of documents in Digitized Shape Editor. Opening a new CATPart Document Opening an existing Digitized Shape Editor Document Importing Files from V4 Saving a Digitized Shape Editor Part



Opening a new CATPart Document This task shows how to open a new CATPart document and activate the Digitized Shape Editor workbench. 1. Select the File -> New commands (or click the New



icon).



The New dialog box is displayed, allowing you to choose the type of the document you need. 2. Select Part in the List of Types field and click OK. 3. Choose Digitized Shape Editor from the Start --> Shape menu. The Digitized Shape Editor workbench is loaded and a CATPart document is opened.



The Digitized Shape Editor workbench document is made of: the specification tree and the geometry area in the main window specific toolbars (geometry creation and modification toolbars, analysis toolbar) a number of contextual commands available in the specification tree and in the geometry. Remember that these commands can also be accessed from the menu bar. The specification tree is a unique specification-driven and generative tool, which captures and reuses process specifications, ultimately accelerating the design process. It lets you concentrate the design effort on establishing the proper design specifications, while leaving it to the system to compute or update the resulting geometry when required. This specification tree can be customized using the Tools --> Options menu item, Tree tab. In Digitized Shape Editor, the name of the elements created in the specification tree is based on the name of the corresponding command, except for Offset: the name of the element created derives of that of the initial element. If you wish to use the whole screen space for the geometry, uncheck Specification in the View menu. You could also directly choose Digitized Shape Editor from the Start menu. It would automatically open a new CATPart document.



Opening an existing Digitized Shape Editor Document This task shows how to open an existing Digitized Shape Editor document. 1. Select the File -> Open command (or click the Open



icon).



The File Selection dialog box is displayed. Browse your directories to select the CATPart document to open. 2. Choose Digitized Shape Editor from the Start --> Shape menu.



The Digitized Shape Editor workbench is loaded and a CATPart document is opened.



Importing Files from V4 CATIA Version 5 includes unique two-way interoperability with CATIA Version 4 data, thus allowing CATIA Version 5 to benefit from the breadth of the CATIA Solutions Version 4 portfolio. CATIA Version 5 data can be loaded and processed in a CATIA Version 4 session. Similarly, CATIA Version 4 data can be read in a CATIA Version 5 session and converted to a CATIA Version 5 format for further edition. Refer to the CATIA V4 Integration User's Guide for further details on how CATIA Version 4 and Version 5 interoperate.



Saving a Digitized Shape Editor Part This task shows how to save an Digitized Shape Editor document. 1. Select the File -> Save as command. The Save as dialog box is displayed.



2. Select the type under which you want to save your model : CATPart, stl, igs, wrl, model, stp. 3. Select the target directory and enter the name of your model.



Importing Files This chapter deals with the methods used to import files. Importing One File Importing a Set of Files



Importing One File This task shows how to import a digit file describing a cloud of points (scanned or computed). See also the documentation about Importing a Set of Files. Use the Carmirror1.cgo_ascii file in the samples directory.



1. Select the Import icon



. The Could Import dialog box is displayed.



2. In the Format field, select the file format among the following ones: Ascii free, Atos (the quality of the points can be taken into account), Cgo, Hyscan, Iges (with the exception of 116 entities), Kreon Steinbichler (as points, grids or scans), Stl (with creation of free edges and facets, if requested). 3. In the Selected File area, use the button ... to browse your directories and select a file. 4. In the Options field: Check the box Statistics to display information about the model you are importing. Enter the Sampling percentage to apply; The sampling value determines the percentage of points or scans or grids that will be read from the digit file. Enter the Scale factor to apply to the model, as well as the Unit used in the file.



If the extension of the file you have selected is consistent with the list proposed, the Format field is updated automatically. Otherwise, be careful to enter the correct format in that field. Once you have performed an import operation, Digitized Shape Editor proposes the last entered file path and format as default. If you click on ..., the last entered directory is proposed as default. The File unit option is not relevant to the Steinbichler format, nor the Sampling percentage to the Stl format. 5. For some digit file formats, you may want to enter additional data that are displayed by clicking the button More>>



For Ascii:



For Atos:



For Iges:



For Stl:



Direction and Delimitors apply to scans. Enter these data whenever you know them. Minimal Point Quality is used to clean Atos file from invalid points. The quality value of a point lies between 0 and 255 (low to high). Choose a value to ignore points below that value: Minimal Point Quality value is 125:



Minimal Point Quality value is 75:



System applies to the operating system (Unix or Windows NT) used to generate the binary data: select Same if you know you are using the same operating system as the one used to generate the binary data, Other for the other way, Unknown if you have no indication. Free Edges is used to create or not the scans representing the free edges of a cloud of points:



or



Facets is used to create or not the facets of the imported cloud of points:



or 6. Click Apply to display the cloud of points:



7. Push the button Update to display the bounding box of the cloud. Use the green arrow to resize it in order to import only a part of the cloud.



The bounding box appears every time the cursor passes over a cloud of point. Its size corresponds to that of the visible points.



The check box Replace is used to replace the current cloud of points by a new one. 8. Once you are satisfied with the preview, click Apply and OK to finish the import of the cloud of points.



An element is created in the specification tree, under the name Cloud Import.x. Undo and Redo are available. Digitized Shape Editor memorizes the data of the last imported file and proposes them at the next import action.



Importing a Set of Files This task shows how to import several digit files describing a cloud of points (scanned or computed). Use the MultiImport1.cgo_ascii, MultiImport2.cgo_ascii, MultiImport3.cgo_ascii from the samples directory. . The Could Import dialog box is displayed. The operating 1. Select the Import icon mode is the same as for one file. The files to import must: have the same format, be located under the same directory.



The Selected File field looks like this: All the files are imported as one single cloud of points instead of several:



The three digit files have been imported separately, resulting in three clouds of points.



The three digit files have been imported together, resulting in one cloud of points. One Element Cloud Import.x is created in the specification tree. You can also merge several clouds of points into one whenever necessary, using the Merge Clouds command.



Exporting Clouds of Points This chapter deals with the export of cloud of points to various formats. You can export only one element at a time.



Exporting to ASCII keeping the Scans Exporting to STL from the Polygon Exporting to cgo



Exporting Clouds of Points to ASCII files This task shows how to export a cloud of points to ASCII, either as a cloud of points or as a set of scans: if the selection contains only a scan or a set of scans, they are exported as scans, if the selection contains only a cloud of points, it is exported as a cloud of points, if the selection contains both, the scans are exported. Open the ExportScan1.CATPart model the from the samples directory. This model is made of two elements: a cloud of points (Cloud Import.1) and a set of scans grouped into one element (Planar Sections.1).



1. Select the Scans element and then the export . icon The export dialog box is displayed. 2. In the Save as type field, select the requested format : Ascii free. 3. Browse



your directories and enter the target directory and file name. Then click Save.



4. You can then use the Import action to recall the file you have created.



The scans exported have the following delimiters: G08 for the start and G09 for the end. You can export only one element at a time. Therefore, if you want to export several scans, you must use the Grouped into one element option when you create them.



Exporting Clouds of Points to STL from the Tessellation This task shows how to export a cloud of points to binary Stl format. Open the CloudToStl1.CATPart from the samples directory and polygonize it using the tessellation action. This model is made of two elements: a cloud of points (Cloud Import.1) and a tessellation (Cloud Tessellation.1).



1. Select the Cloud Tessellation.1 and then the export icon . The export dialog box is displayed. 2. In the Save as type field, select the requested format : Stl. 3. Browse your directories and enter the target directory and file name. Then click Save.



4. You can then use the Import action to recall the file you have created.



You can export only one element at a time.



Exporting Clouds of Points to cgo This task shows how to export a cloud of points to cgo Select the Cloud1.CATPart file from the samples directory. 1. Select the Cloud element and then the Export . icon The export dialog box is displayed. 2. In the Save as type field, select the requested format : Cgo. 3. Browse your directories and enter the target directory and file name. Then click Save.



4. You can then use the Import action to recall the file you have created.



You can export only one element at a time.



Editing Cloud of Points This chapter deals with the edition of clouds of points, i.e. Selection and Remove actions. Although the dialog boxes look similar, the operating mode of the Select and Remove actions are slightly different: De-activated points can be recalled using Activate all and Invert in a new activation action. Removed points can not be recalled! Activate all and Invert apply only to the current removal action. They can not be used to recall removed points, once you have clicked OK.



Activating a Portion of a Cloud Removing a Portion of a Cloud



Activating a Portion of a Cloud of Points This task shows how to select a portion of a cloud of points with a 2D or 3D trap, in order to create a work area. Open the Cloud1.CATPart model the from the samples directory.



1. Select the Activate icon and the cloud of points. The Activate Points dialog box is displayed. The Apply button has been replaced by the Valid Trap button and the OK button: To activate an area by picking elements, select them and click OK to confirm the activation and close the dialog box. To create a single activation area by trap, draw the trap, modify it when necessary and click OK to confirm the activation and close the dialog box. To create several activation areas by traps, draw the first trap, modify it when necessary, click Valid Trap to validate this trap. Repeat these steps for each trap then click OK to confirm the activation and close the dialog box. You can define : the Selection Type : Pick: activation occurs by direct picking, according to the level of selection:



Point



Scan or Grid



Digit (element of a cloud)



Cloud (global cloud)



Trap: the points are selected using a graphic trap: either Rectangular or



Polygonal.



As long as you have not double-clicked to end the polygonal trap, you can undo/redo each pick of the polygonal trap. The activated points are those that appear in red during the selection. By default, as shown above, the trap is displayed in the view plane. It is thus a 2D trap. You can rotate the model to display it as a 3D trap. You can modify the shape of the trap using the green arrows that appear on the edges of the trap.



You can create as many areas as you wish by clicking Valid Trap and drawing another trap, until you click OK to validate and exit the action.



If you draw a trap and click Valid Trap, and then choose Swap, you validate the complement of the trap.



2. You can choose to keep the points : Inside the trap or Outside the trap.



3. You can select an activated portion of a cloud of points and recall the activation action to: Activate all (all the points of the original cloud are recalled), Swap the selection (the complement of the current selection becomes active whereas the current selection is hidden) The effect of an activation is now visible even on a shaded tessellation.



The free edges displayed are those of the complete cloud of points: if you activate only a portion of a cloud of points, the free edges of that portion are not displayed.



Removing Points from a Cloud This task shows how to remove a portion of a cloud with a 2D or 3D trap. Open the Cloud1.CATPart model the from the samples directory. 1. Select the Remove icon dialog box is displayed.



. and the cloud of points. The Selection



The Apply button has been replaced by the Valid Trap button and the OK button: To activate an area by picking elements, select them and click OK to confirm the activation and close the dialog box. To create a single activation area by trap, draw the trap, modify it when necessary and click OK to confirm the activation and close the dialog box. To create several activation areas by traps, draw the first trap, modify it when necessary, click Valid Trap to validate this trap. Repeat these steps for each trap then click OK to confirm the activation and close the dialog box. 2. You can define : the Selection Type : Pick: activation occurs by direct picking, according to the level of selection:



Point:



Triangles:



Scan or Grid:



Digit (element of a cloud):



Cloud (global cloud):



Trap: the points are selected using a graphic trap:



either Rectangular or



polygonal



As long as you have not double-clicked to end the polygonal trap, you can undo/redo each pick of the polygonal trap.



The deleted points are those that appear in red during the selection. By default, as shown above, the trap is displayed in the view plane. It is thus a 2D trap. You can rotate the model to display it as a 3D trap. You can modify the shape of the trap using the green arrows that appear on the edges of the trap.



You can create as many areas as you wish by clicking Valid Trap and drawing another trap, until you click OK to validate and exit the action.



If you draw a trap and click Valid Trap, and then choose Swap, you validate the complement of the trap.



3. You can choose to keep the points : Inside the trap or Outside the trap.



4. Within one removal action, use: Activate all to recall all the points of the original cloud of points, Swap to invert the selection (the complement of the current selection becomes active whereas the current selection is hidden). Undo/Redo are not available. Although the dialog boxes look similar, the operating mode of the Select and Remove actions are slightly different: Removed points can not be recalled! Activate all and Swap apply only to the current removal action. They can not be used to recall removed points, once you have clicked OK. All free edges may be displayed.



Creating Sections This chapter deals with the creation of sections on a cloud of points. Cutting a Cloud by Planar Sections Projecting Curves on Clouds



Cutting a Cloud by Planar Sections This task shows how to cut a cloud by planes. Open the Cloud1.CATPart model the from the samples directory.



and the cloud of points. The 1. Select the Planar Sections icon Planar Sections dialog box is displayed as well as a default reference plane and a default number of cutting planes and step. One manipulator is available on the reference plane. It can be used to position the reference plane.



Another manipulator is available on the last cutting planes proposed. This manipulator is used to modify either the step between cutting planes, or the number of planes, depending on the option selected in the Fixed field or in the contextual menu attached to this manipulator.



2. Use the Plane Definition icons to select the reference plane according to your need: push the YZ or XZ predefined plane, or



or XY



icon to select a



push the compass icon to orient the reference plane with the compass, or push the plane icon



to select an existing plane or



push the section guide icon and select a curve: the sections will be perpendicular to this curve. The degree of the section guide must be greater than 2. Once the section guide is selected, the Limitation box becomes available.



3. After setting the orientation of the reference plane, you can move it along its normal or along the section guide by dragging the center of the green manipulator in the required direction. You can also use the Reverse button to invert the cutting direction. 4. If required, you can select one or two limiting curves. Pick the first limiting curve, its name is displayed in the First curve field. You can then select a second limiting curve. Its name is displayed in the Second curve field. The limiting curves should lay on the cloud of points. The section guide curve can be selected as second limiting curve (not as the first). To replace a limiting curve by another, uncheck the corresponding field: the name is erased. Check the field again and select the new curve. Its name is displayed. Be careful to choose a view parallel to the screen, and to check the Lock Privileged Plane Orientation Parallel to Screen option of the compass.



5. Cutting planes can be defined : either from the step (distance) between two consecutives planes: check Fixed, Step, then enter the value of the Step in the dialog box, and enter the Number of planes in the dialog box or drag the green arrow until you reach the required number of planes (the dialog box is updated automatically).



or from their number : check Fixed, Number, then enter the Number of planes in the dialog box, and enter the Step between two planes or drag the green arrow until you reach the required step (the dialog box is updated automatically).



You can also check the Infinite option, especially when dealing with large models. In that case, the planes displayed on screen are used only to position the reference plane and define the step between two planes, if it is not fixed. The system computes all the cutting planes necessary to cut the whole model.



6. The Influence Area parameter defines a computation area around the cutting planes: when the points are not dense, a cutting plane (black line) may be unable to intersect the points. The Influence area is the area shown in yellow that contains the points considered to intersect the cutting plane. You can define its value according to your needs.



7. Select the type of the result scans: either :



Distinct: the intersections are created as as many Planar Sections elements in the specification tree.



Grouped into one element: the intersections are created as one cloud (one Planar Sections element) in the specification tree. :



8. Click Apply to check or update the result. Then click OK to confirm the result and exit the action.



Although cutting a cloud of points is quicker (no need to tessellate first), creating planar sections on a tessellation rather than on a cloud of points has some advantages: the action is dynamic on tessellations: no need to apply to visualize the modifications (position of the reference plane, step, number of planes,...), In the case of a cloud of points, the intersection may be interpolated, since the plane does not necessarily intersect points. That problem is reduced with tessellations since the plane intersects facets, providing a better accuracy.



The scans are created in the specification tree, as Planar Sections.x. The scans created are ordered. Scans can then be exported to an ASCII file.



Projecting Curves on Clouds This task shows how to project curves on clouds. Open the CurvesOnCloud1.CATPart model the from the samples directory. 1. Select the Curve on Cloud icon The curve projection dialog box is displayed. 2. Select the curves to project and the target cloud.



.



3. Select the projection direction using the compass: position the compass on one curve to project and choose an orientation. The curve(s) will be projected along the w-axis of the compass.



4. Select the number of points for the discretization of the projected curves. For example 10 or 20 :



5. Set the working distance: the input curve is discretized, and each discretization point is projected on the cloud. The working distance is the distance taken into account around each projection point to compute the output scan. Enter 10 then 2 :



6. Click Apply to check or update the result. Then click OK to confirm the result and exit the action. Scans are created in the specification tree under the name Curve Projection.x.



Creating Curves This chapter deals with the methods used to curves in the Digitized Shape Editor. Curves on Plane Curves in Space Curves from Scans



Curves on Plane This task explains how to create curves on a virtual plane. Open a new .CATPart document. 1. Click the Curve on Plane icon 2. Use the 3D compass to define the plane in which the curve is to be created, or select one of the document pre-defined planes. Right-click the 3D compass to display more orientation options. 3. Define the curve creation mode using the Planar Curve dialog box: the curve can be created by interpolation or smoothing. If you choose to use the Through Points mode, the resulting curve is a multi-arc curve passing through each selected point. If you choose the Near Points mode, the resulting curve is a single-arc, with a set degree and smoothed through the selected points. If you choose the Control Points mode, the points you click are the control points of the resulting curve, as if you were using the editing capabilities. If you click the closure icon, you can create a closed curve. The curve properties will be updated as you create the curve.



4. You can choose one of the three display options: Click the Porcupine Analysis



icon if you want to display a porcupine



analysis Click the Hides or shows grid Click the third



icon to display or hide the planar grid



icon to display the distance between points and curve



(only in Near Points mode) 5. Click anywhere in the document to define the first end point of the curve. You can click in space or on existing geometry. A dot is displayed where you clicked and a rubber band bounding box appears when you move the pointer. 6. Click as many times as needed to create points through which the curve must pass. The curve and its bounding box are previewed as you move the pointer around.



7. Double-click, or click OK in the dialog box, to create the end point of the curve. The curve has been created in the plane you previously defined, and can now be used for other purposes, such as performing operations on curves, analysis purposes, extruding surfaces, and so forth.



When using the Control Points creation option, you can create a mono-arc curve up to six points, then if there are more than six points, the system automatically generates a multi-arc curve. As soon as you click the first point, the plane can no longer be modified. You cannot create closed curves. You can create curves symmetrically in relation to a specific angle from the creation plane: icon from the Planar Curve dialog box. . Click the Mirror Symmetry An axis is displayed lying on the creation plane and passing through the first point. The displayed value is the angle value in relation to this plane. b. Right-click the angle value to edit it via the Angle Tuner dialog box and press Enter. You could also directly modify the angle and the axis origin using the manipulators. c. Move the pointer where you wish to click the second point. The symmetric curve is previewed. d. Proceed as for a regular curve.



Creating Free Form Curves in Space This task explains how to create curves in space. These are defined by specific points lying on pre-existing geometric elements. Open the CurveInSpace1.CATPart document from the samples directory. 1. Click the Curve in Space icon



.



The Curve on Geometry dialog box is displayed. 2. Choose the type of curve creation: If you choose to use the Through Points mode, the resulting curve is a multi-arc curve passing through each selected point. If you choose the Near Points mode, the resulting curve is a single-arc, with a set degree and smoothed through the selected points. This mode enables you to



define the tangency at extremities for planar curves. If you choose the Control Points mode, the points you click are the control points of the resulting curve, as if you were using the editing capabilities. If you click the Closure icon, you can create a closed curve. 3. You can choose one of the three display options: Click the Porcupine Analysis



icon if you want to display a



porcupine analysis Click the Hides or shows grid



icon to display or hide the



planar grid Click the third



icon to display the distance between



points and curve (only in Near Points mode)



4. Move the pointer close to the geometry on which you want the first point of the curve to lie and click.



5. Click as many locations as you wish the curve to go through. Dots and manipulators are displayed on the geometry allowing you to modify the location of the starting point for the curve. Moreover, the curve is previewed as you move the pointer around.



6. Click OK to create the end point of the curve. The curve has been created passing through key points on existing geometric elements. When using the Control Points creation option, you can create a mono-arc curve up to six points, then if there are more than six points, the system automatically generates a multi-arc curve. You cannot create closed curves.



Curves from Scans This task shows how to create curves from a scan or a set of scans. Open the Scan1.CATPart model the from the samples directory.



and 1. Select the Curve from scans icon the cloud of points. The Curve from scans dialog box is displayed. 2. Select a set of scans. A temporary curve is proposed on each scan selected, and the minimum and maximum distances between that curve and the points of the scan are displayed.



3. Reduce the accuracy value to reduce those distances.



Accuracy=0.293



4. You can modify the creation mode of the curve: Smoothing: the curve is created by smoothing all the points of its support scan.



Interpolation: the curve is created by interpolating the points of its support scan.



5. You can define a split angle: if the curve reaches that angle, it is split into two curves. The split spot is displayed and two curves are created.



The modifications are dynamic and displayed in real time on the screen. 6. Click OK to exit the action and create the curve(s). Curve.x elements are created in the specification tree.



Operations on Cloud of Points This chapter deals with operations on a cloud of points. Merging Cloud of Points Aligning Clouds



Merging Cloud of Points This task shows how to merge clouds of points. Open the Merge1.CATPart model the from the samples directory. It consists of three clouds of points that have been imported separately. 1. Select the Merge icon . The Cloud Union dialog box is displayed. 2. Select the clouds you want to merge. The list in the dialog box is updated. 3. To remove a cloud from the list of clouds to merge, make its name active in the list and check Remove. 4. To replace a cloud in the list of clouds to merge, remove it, then select a new cloud. 5. Once you have selected all clouds to be merged, click OK. A new cloud is created.



An element Clouds Union.x is created in the specification tree. You could also import a set of clouds.



Aligning Clouds This task shows you how to align clouds of points, either to another cloud of points, or to a surface. Open the Reposition1.CATPart model the from the samples directory. It consists of two clouds of points with three spherical tags on each. These tags have been created during digitizing in order to align the two clouds in future operations. 1. Select the Align with Cloud icon displayed.



or the Align with Surface



icon. A selection dialog box is



The Apply button has been replaced by the Valid Trap button and the OK button: To activate an area by picking elements, select them and click OK to confirm the activation and close the dialog box. To create a single activation area by trap, draw the trap, modify it when necessary and click OK to confirm the activation and close the dialog box. To create several activation areas by traps, draw the first trap, modify it when necessary, click Valid Trap to validate this trap. Repeat these steps for each trap then click OK to confirm the activation and close the dialog box. 2. Select first the cloud(s) to move (in fact the output cloud is a moved copy of the initial cloud, which can then be hidden if necessary). 3. Then select the target cloud or the target surface.



4. Define significant common areas on each cloud (source and target) to align using the Alignment dialog box (its operating mode is the same as Activating a Portion of Cloud). Click Valid Trap between each area definition, and OK when all areas have been defined, on the source clouds first, then on the target cloud. These areas are the basis of the computation. They may have any shape, be in any number. In this case, the significant area are the circular tags. As long as you have not double-clicked to end the polygonal trap, you can undo/redo each pick of the polygonal trap. If the target is a surface, there is no need to define a computation area on it. 5. After the last OK, CATIA proposes to compute the first move: Answer Yes: CATIA aligns the center of gravity and the inertia axes of the parts, then the position of each part. Answer No: CATIA aligns only the position of each part. This is recommended when the alignment of the parts is already almost correct.



If you select the center of gravity option (Yes): you can repeat the process to improve the alignment, but this time, do not accept the automatic first move. the clouds to align should not contain a large amount of points, the shape of the traps on each cloud should be similar. If you select the other option (No): the clouds may contains a large amount of points, the traps should contain coincident points . In both cases, the trap(s) on the target(s) should contain more points than the trap(s) of the source cloud(s). While aligning a cloud with a surface, you can use the function Distance analysis to check the output accuracy. The target will be the output cloud. Since a new output cloud is generated at each alignment, you should repeat the distance analysis with each new output cloud.



The result entity has the same structure as the input entity: scans, grids or polygons.



Analysis This chapter deals with the analysis and display option of clouds of points. Display Options Distance Analysis



Display Options This task shows how to change the display option of clouds of points. Open the Visu1.CATPart model the from the samples directory. It consists of four clouds of points: a tessellation, a cloud of points, a set of scans, a set of grids. at the 1. Select the Cloud icon bottom of the screen. The Cloud Display Option dialog box is displayed. 2. Select the cloud to modify. CATIA proposes display options according to the type of the cloud selected:



3. For the cloud of points, you can: change the symbols of the points from the list:



display the points that are protected (not yet implemented). For the sets of scans or grids, you can: display them as line of points or points:



display their orientation (not yet implemented).



For the tessellation, you can: display the triangles, the vertex (not yet implemented), the free edges, the shrink (not yet implemented), the normals (not yet implemented).



display the tessellation as flat (not yet implemented) or smooth.



The free edges displayed are those of the complete cloud of points: if you activate only a portion of a cloud of points, the free edges of that portion are not displayed.



if you remove a portion of a cloud of points, the free edges of the remaining portion are displayed.



You can change the color of an element with the Properties menu of the element, in the Graphic tab.



Analyzing Distances Between Two Sets of Elements This task shows how to analyze the distance between a cloud of points and a surface, but this analysis can be performed on any two sets of elements. Open the Analysis1.CATPart document from the samples directory. 1. Select a surface. 2. Click the Distance Analysis icon



.



The Distance Analysis dialog box is displayed. 3. Select a target element. This element is automatically discretized, except if you choose a cloud of points. The distance analysis is computed. Each color identifies all points located at a distance between two values displayed in the Distance Analysis dialog box.



You can choose different modes to display the colors (linear, sharp left, sharp right and center) and dynamically modify the ranges by sliding the arrows. The analysis representation in the color range varies according to the chosen option. 4. Move the red slider to the right. The value range is automatically updated and the geometry dynamically reflects the slider modifications. Here the area where the distance deviation is important has been reduced. 5. Two analysis modes are available: a. Full: provides a complete analysis based on the chosen color range. This allows you to see exactly how the evolution of the distance is performed on the selected element. This is the default mode. b. Quick: provides a simplified analysis, but lets you define the tolerance within which the distance deviation should be. For example, for positive values, if the deviation is bigger than 0.010, the points are red, if the deviation is smaller than 0.010, the points are green.



If we change the first spinner to 20.0 in this example, the resulting geometry would be:



The Direction option helps you define the projection of the vector between the target point and the source element. Using the 3D option, the vector itself is displayed Using the X, Y or Z plane option, the vector is projected according to the selected axis Using the compass option, the vector is projected according to the compass orientation. 6. Use the Display area to the distance representation: either the color is displayed on points, the spikes can be displayed and inverted, the envelope, that is the curve connecting all spikes together, the minimum and maximum values (Information option). Finally, the Scaling option lets you define the visualization of the comb. In Automatic mode the comb size is zoom-independent and always visible on the screen, otherwise you can define a coefficient multiplying the comb exact value (distance). 7. Use the Discretization option to limit the number of points of the target element taken into account when computing the distance deviation. In Full analysis mode, but with a discretization of 25, the results would look like this. When the source element is a surface and the target a cloud of points, you can automatically delimit the target points to be taken into account for the computation by activating the Automatic trap, thus improving the performances. 8. Choose whether you wish to see the normal distance, that is distance between the target point and its normal projection onto the source element, or the minimum distance, that is the smallest distance from the target point to the source. The normal distance may not exist, as shown on the end-points of the curve to the right..



9. Click OK to exit the analysis.



Tessellation This chapter deals with the tessellation of clouds of points. Tessellating a Cloud of Points Offsetting a Tessellation Merging Tessellations



Tessellating a Cloud of Points This task shows how to tessellate a cloud of points. Open the Tessellation1.CATPart model from the samples directory.



. The 1. Select the Tessellate icon Cloud Tessellation dialog box is displayed. 2. Select the cloud of points. A Neighborhood value is proposed in accordance with the model. This value represents the maximal edge length of the triangles displayed. The value proposed is just an approximation of this value. Its relevance depends on the distribution of the points in the cloud. It is visualized by a sphere. You can change its position by a simple mouse click.



The sphere is updated when you change the Neighborhood value.



3. Check the Display option you need: Triangles to display only the tessellation, Shading to simulate the surface of the object: with the Flat option, the light is sent on the triangles along their normal, with the Smooth option, the light is smoothed over the triangles, giving a better image of the quality of the surface. 4. Constrained is used to: re-process a portion of a tessellation: Open the Tessellation2.CATPart model from the from the Samples\DSP directory. The original tessellation had holes in it. Select a faulty portion and proceed to a new tessellation on that portion. The original tessellation is in red. The re-processed tessellation is in blue. connect several tessellations: Open the Tessellation3.CATPart model from the from the Samples\DSP directory. Draw two traps on that part and tessellate them with different values, as shown below. Now activate the remaining square of points, as shown below. For quicker tessellation performances, you can filter portions of the parts according to your successive needs.



The tessellation is constrained, the activation trap overlaps the previous The tessellation is unconstrained, the tessellations. The resulting tessellation activation trap does not overlap the is connected to the other two. Facets of previous tessellations. The resulting the existing tessellation that were tessellation is independent from the totally or partially inside the trap have other two. been removed and recomputed to adjust to the additional tessellation.



Check the Manual option if you are in a constrained tessellation mode!



5. Check the Execution Mode option you need: Automatic: the system computes the tessellation for a quick and rough view, Manual: you can select the plane that is the reference of the tessellation computation, using the compass. This may improve the result (better polygons):



6. Click Apply to check or update the result. Then click OK to confirm the result and exit the action. An element Cloud Tessellation.x is created in the specification tree.



Increase the Neighborhood value to improve the tessellation: Triangles:



Shading:



In some cases, it may be difficult to find a Neighborhood value that will fill unwanted holes, without creating unwanted triangles:



Seams may appear on the tessellation with the Smooth option, : They indicate that the normals to the facets have different directions at this place. In Automatic mode, some triangles may overlap and tessellation should be corrected. In Manual and Constrained mode, they show the common boundaries of tessellations. When computing a constrained tessellation, enter 0 as the Neighborhood value to check the boundaries of the tessellation. If the boundaries are not satisfactory, modify the tessellation plane to improve them. After the computation of a constrained tessellation, two tessellation elements are visible in the specification tree: the constrained tessellation and the initial tessellation. You can select one and then the other to make sure they are complementary.



Offsetting the Tessellation This task shows how to offset a tessellated cloud of points. Open the OffsetTessellation1.CATPart model from the samples directory.



1. Select the Offset icon displayed.



. The Offset Tessellation dialog box is



2. Select the tessellation. 3. Enter an Offset value. The offset tessellation is displayed, together with a green vector representing the offset.



4. Check the Create scans option if necessary, to create the free edges scans:



5. Click Apply to check or update the result. Then click OK to confirm the result and exit the action. The element Offset Polygon.x is created in the specification tree. In this release, a clipping problem may affect the bounding box of the offset tessellation. The offset is computed in the direction of the weighted normals of the points. For better results, you should avoid to enter a high offset value.



Merging Tessellations This task shows how to merge two tessellations. This action is useful especially for polygons resulting from a constrained tessellation: it removes the seam created by the constrained tessellation. Open the MergePolygons1.CATPart model the from the samples directory. It consists of two polygons, the smallest resulting from a constrained tessellation. 1. Select the Merge Tessellations



icon . The Tessellations Merge dialog box is displayed.



2. Select the tessellations you want to merge. The list in the dialog box is updated. 3. To remove a tessellation from the list of tessellations to merge, make its name active in the list and check Remove. 4. To replace a tessellation in the list of tessellations to merge, remove it, then select a new tessellation. 5. Once you have selected all tessellations to be merged, click OK. A new single-cell tessellation is created in the specification tree under the name Tessellations Merge.x.



Advanced Tasks Advanced Tasks in CATIA V5 Digitized Shape Editor are related to the filtering of clouds.



Filtering



Filtering Filtering by Sphere Adaptative Filtering



Filtering by sphere Filtering a cloud of points makes its manipulation easier. This task shows how to filter a cloud of points homogeneously. Open the Cloud1.CATPart model the from the samples directory. 1. Select the Filter icon and the cloud of points. The filtering dialog box is displayed.



2. Select the filtering type Homogeneous: The filtering sphere is visualized by a green sphere. You can change its position by a simple mouse click.



Changing the sphere radius via the Homogeneous spider in the dialog box changes the sphere dimension on the screen and the filtering percentage: the sphere passes over the cloud of points, starting on the first point met. All the points that are inside the sphere are then hidden. The sphere goes to the next remaining point and removes the points that it contains, and so on.



3. Each time you click Apply, the cloud of points and the statistics are updated. 4. Check the Physical removal option to delete the filtered points, thus optimizing the memory requirements. 5. Once you are satisfied with the result, click OK to confirm and exit the action. The points are hidden, not removed, unless you use the Physical removal option. Within a filtering action, Undo cancels the last filter action performed. Leaving the action with Cancel restores the cloud as it was before starting the filtering action. Filtering with a radius equal to 0 cancels ALL filtering actions performed on the cloud of points: It is not possible to filter a tessellated cloud of points or a polygon. When you filter scans or grids, you actually filter points: filtered points are hidden, and new scans or grids are created. Points that have been physically removed can not be retrieved.



Adaptative filtering Filtering a cloud of points makes its manipulation easier. This task shows how to hide points on planar elements. Open the Adaptative1.CATPart model the from the samples directory. 1. Select the Filter icon



and the cloud of points.



The filtering dialog box is displayed.



2. Select the Adaptative filtering type. The value to enter represents the local chordal deviation. This filtering hides more points from the planar areas than from other areas. That way, you can highlight bent areas.



3. Each time you click Apply, the cloud of points and the statistics are updated. 4. Check the Physical removal option to delete the filtered points, thus optimizing the memory requirements. 5. Once you are satisfied with the result, click OK to confirm and exit the action. The points are hidden, not removed, unless you use the Physical removal option. Within a filtering action, Undo cancels the last filter action performed. Leaving the action with Cancel restores the cloud as it was before starting the filtering action. Filtering with a radius equal to 0 cancels ALL filtering actions performed on the cloud of points: It is not possible to filter a tessellated cloud of points or a polygon. When you filter scans or grids, you actually filter points: filtered points are hidden, and new scans or grids are created. Points that have been physically removed can not be retrieved.



Workbench Description This chapter describes the menus, sub-menus, items and toolbars of the Digitized Shape Editor. Menu Bar Creation Toolbars Analysis Toolbars Specification Tree



Menu Bar This chapter describes the menus available in Digitized Shape Processor. Other menus are documented in the CATIA Version 5 Infrastructure User's Guide. File Edit View Insert Tools Window Help



File This menu is used to create new CATPart documents, open existing CATPart documents, saving CATPart documents in Digitized Shape Editor.



For



See



New... Opening a new CATPart Document Open... Opening an existing Digitized Shape Editor Document



Save... Saving a Digitized Shape Editor Part



For the other menu items, please refer to the CATIA Version 5 Infrastructure User's Guide.



Edit The Edit menu lets you manipulate selected objects.



Please refer to the CATIA Version 5 Infrastructure User's Guide.



View The View menu lets you view document contents and toolbars. For



See



Toolbars



Digitized Shape Editor Toolbars



Cloud Display Options



Display options



For the other menu items, please refer to the CATIA Version 5 Infrastructure User's Guide.



Digitized Shape Editor Toolbars For



See



Cloud Analysis



Distance Analysis



Cloud Display Options



Display Options



Cloud Edition



Editing Clouds and Filtering



Import and Export



Importing Files and Exporting a Cloud



Cloud Operations



Operations on Clouds



Cloud Primitives



Cloud Primitives



Cloud Tessellation



Tessellation



Curve Creation



Creating Curves



Section Creation



Creating Sections



Selection on Cloud



Activating a Portion of a Cloud of Points



For the other menu items, please refer to the CATIA Version 5 Infrastructure User's Guide.



Insert This menu is used to insert Digitized Shape Editor elements. For



See



Cloud Import



Importing Files Exporting a Cloud



Cloud Export Cloud Edition:



Activating a Portion of a Cloud Filtering Removing a Portion of a Cloud



Section Creation:



Projecting Curves on Clouds Cutting a Cloud by Planar Sections



Curve Creation:



Curve in Space Curve on Plane Curve from Scans



Operations: Merging Clouds



Aligning Clouds Analysis: Distance Analysis Tessellation:



Tessellating a Cloud Offsetting a Tessellation Merging Tessellations



For the other menu items, please refer to the CATIA Version 5 Infrastructure User's Guide.



Tools The Tools menu lets you perform image capture and album management, set user preferences and manage macros.



Please refer to the CATIA Version 5 Infrastructure User's Guide.



Window The Window menu lets you arrange document windows in relation one to the other.



Please refer to the CATIA Version 5 Infrastructure User's Guide.



Help The Help menu lets you get help on the currently active command, and the product in general.



Please refer to the CATIA Version 5 Infrastructure User's Guide.



Creation Toolbars They are the following: Import and Export Cloud Edition Section Creation Curve Creation Operations Analysis Tessellation



Import and Export For



See



Import Importing Files Export Exporting a Cloud



Cloud Edition For



See



Select



Activating a Portion of a Cloud



Filter



Filtering



Remove Removing a Portion of a Cloud



Section Creation For



See



Curve on Cloud Projecting Curves on Clouds Planar Sections Cutting a Cloud by Planar Sections



Curve Creation For



See



Curve in Space



Curve in Space



Curve on Plane



Curve on Plane



Curve from scans Curve from Scans



Operations For



See



Merge Merging Clouds Align Aligning Clouds



Analysis For



See



Distance Analysis Distance Analysis



Tessellation For



See



Tessellation



Tessellating a Cloud



Offset



Offsetting a Tessellation



Merge Tessellations Merging Tessellations



Analysis Toolbar It contains the following tool: Display Options



Display Options For



See



Display Options Display Options



Specification Tree The specification tree portion specific to Digitized Shape Editor looks like this:



The icon represents a Digitized Shape Editor body, composed of an imported cloud and of the operations performed on this cloud such as sectioning by planar sections, tessellation, etc. The name of the elements created by these operations in the specification tree is based on the name of the corresponding command, except for Offset: the name of the element created derives of that of the initial element. The



icon represents a distance analysis



Glossary activate align cloud of points



digit



filtering



neighborhood



remove



This function is used to define a particular portion of a cloud for further operations. This function is used to reposition several digits to each other in order to reconstruct a complete object. A cloud of points is defined as a set of points in 3D space. It may consist of a single point or several million of points. Those points may be the result of a digitizing or of a computing operation. In the current manual, the term cloud of points refer to several representations: representation as a set of points, representation as a set of lines of points (or scans), representation as a set of grids, representation as a tessellation (or mesh, or polygon). A cloud of points may consist of several digits (i.e. sub-clouds): for example, the cloud of points representing the handle below consists of two digits.



Filtering a cloud of points is a method to create a lighter working context: some points are hidden, thus making further operations on the cloud quicker. Those hidden points can be recalled later. Many functions in Digitized Shape Editor operate on the points in space, regardless of the organization of the data in the cloud. In these functions, you can specify a maximum distance (neighborhood) which will be considered around a point for the operation. The larger the neighborhood value, the more points will be considered, and possibly the operation may become slower. A default neighborhood value is proposed in those functions. This function deletes physically points from the cloud of points. The points can not be recovered.



scan sampling shading



tessellation



Cloud of points can be organized in consecutive scans, that is points in parallel planes. This operation is performed while importing a cloud of point. You can choose to import only a percentage of the points of the cloud. A tessellation can be visualized in shaded mode. This mode is a method for visualizing the point data and getting an impression of its quality. A tessellation (or polygon or mesh) consists of a set of polygonal faces which represent the surface of a 3D model. A triangulation is computed to describe the neighborhood relation of all points.



A tessellation can be used to check the quality of the points, or can be processed in other CATIA V5 applications. working distance This is the distance beyond which the elements are not taken into account for a computation.



Index A analysis distance , , mode direction discretization display scaling porcupine ,



B bounding box



C curves closed control points , discretization interpolation near points , smoothing split symmetry through points , working distance



D delimitor



F facet file unit format free edge



G grid



,



M minimal point quality



N neighborhood



P planar sections drive guide influence area number step type



S sampling scale factor selection type



trap shading sphere system



T tessellation constrained free edge mode offset shading



U update
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